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1. Overview 
Thank you for purchasing the OtoSim 2™ Otoscopy Training and Simulation 
System. 

OtoSim Inc. has worked hard to develop an integrated and interactive 
simulation system that will significantly improve the effectiveness of	
  
otoscopy training. OtoSim 2™ provides the opportunity to effectively learn 
otoscopic techniques through hands-on experience in a simulated ear 
environment. It allows students to practice otoscopic techniques while 
reviewing different clinical scenarios with hundreds of high-fidelity images, 
and with direct and immediate instructor feedback. 

This manual has a number of sections. Some sections are specific to using a 
PC or Mac computer, so you will need to skip over the sections not pertaining 
to your situation. In addition, please run a single OtoSim™ Unit before 
attempting to run multiple units. 

The intent of this manual is to allow a person with basic computer knowledge 
to install the software. A computer with the OtoSim 2™ software preloaded 
and hardware preconfigured can be purchased from us. If you work in a 
networked hospital environment, you may require assistance from your IT 
staff. Alternatively, OtoSim 2™ can be run off of a stand-alone laptop to 
avoid network issues. 

The actual instructions and screenshots may vary slightly from what is 
displayed on your screen, as there are many versions of operating systems. 

The OtoSim™ Base Unit has no on/off switch or independent power. The 
images and the power supply are provided via the single USB cable. To 
power up the OtoSim™ Base Unit, connect the USB cable to the computer, 
and simply disconnect the USB cable to power down the unit when you are 
finished. 

For those with more advanced computer knowledge, the OtoSim™ Base Unit 
is essentially an extension of the desktop monitor via a USB video feed. The 
OtoSim 2™ installation package will load drivers that enable this USB video. 
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When multiplexing (running more than one OtoSim™ Unit at the same time), 
connect the units one at a time and allow the computer to recognize them 
(show them as extended units from the desktop). Your computer screen may 
resize or flash black multiple times during the initial setup. It has been our 
experience that most computers can multiplex up to 6 OtoSim™ Units when 
used with a computer that meets our required specifications. (Please contact 
us if you want to multiplex more than 6 OtoSim™ Units.) You can multiplex 
by connecting to the USB outlets on your computer or by using a powered 
external USB hub. Please refer to Section 6 for suggested configurations. 

If you experience difficulty in setting up the OtoSim 2™, feel free to send us 
an email (info@otosim.com) and set-up an appointment for technical support. 
We will typically respond within 24 hours, Monday to Friday. 

We welcome your feedback on improving OtoSim 2™ and features you 
would like to see in future versions.  
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2. OtoSim 2™ Components 

Your OtoSim 2™ Full System consists of an OtoSim™ Base Unit package 
and an OtoSim 2™ Upgrade Kit. If you did not receive all of the items 
pictured below, please contact us immediately. Please note that you will need 
an OtoSim™ Base Unit to run the OtoSim 2™ Upgrade Kit.  

OtoSim™ Base Unit package includes: 

a) OtoSim™ Base Unit 

b) USB Cable (Type Mini-B to Type A)  

c) Pelican 1300 Protective Case  

a) 

 

b) 

 

c) 

 

OtoSim 2™ Upgrade Kit includes: 

a) OtoSim 2™ Instrumented Otoscope, Sensor Box, Right Earform, 
Left Earform, and Otoscope Cable 

b) USB Key with OtoSim 2™ Software and Installation & User Guide 

c) USB Cable (Type B to Type A) 

d) Pelican 1150 Protective Case 
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a) 

 

b) 

 

c) 

 

d) 

 

  

 

Note: A computer (desktop or laptop) is required to run the OtoSim 2™ but 
is not provided. Please refer to Section 4: OtoSim 2™System 
Requirements to identify a suitable computer to operate this simulation 
system. 

 

 



 
 
 
 

OtoSim 2™ Installation and User Guide  
 
 

5 

3. OtoSim 2™ Features 

 

 

3.1 Basic Features of OtoSim 2™ 

Below is a summary of basic features for your OtoSim 2™ Full System: 

• Detailed text description of ailments, ear and biopsy images provide 
sufficient material for instruction and self-guided tutorials; 

• Proprietary database of over 380 high-resolution images from the 
OtoSim Library to instruct, practice and test students; 

• Annotated anatomical landmarks included on almost 150 images; 

• Realistic earform and canal for students to practice and improve their 
otoscopic technique. Through an actual otoscope, students can practice 
their examination technique with monocular vision while viewing through 
a realistic simulated-ear; 

• Realistic image projection enabling students to view various normal and 
pathological conditions of the middle ear and external auditory canal 
conditions in a realistic earform; 

• Immersive full-screen viewing with a simple, easy to use graphical user 
interface; 
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• Uniques optics maximizing image resolution and clarity; 

• Live landmark annotation enabling instructors to highlight specific 
image characteristics; 

• Advanced Quizzes with randomized, realistic clinical scenarios that test 
both medical and patient interaction skills; 

• Anatomy quizzes where students must point to specific landmarks in time 
to answer the questions; 

• Instrument use tests to aid students in practicing and improving their 
otoscopic technique; 

• Feature identification modules to reinforce basic ear anatomy; 

• Search to quicky find specific cases or review materials; 

• Multiplexing to support up to 14 OtoSim™ Base Units to a single trainer 
laptop to effectively instruct groups at the same time. 

Note: OtoSim recommends a maximum of 6 Base Units multiplexed to a 
single OtoSim-supplied USB hub for PC with Windows 8 (multiple USB 
hubs required for more than 6 units); 6 Base Units for PC with Windows 7, 
Vista or XP; and 4 Base Units for Mac. Please see Section 6.3 for details. 

 

3.2 Unique Features of OtoSim 2™ 

(1) OtoSim 2™ Instrumented Otoscope  

The custom OtoSim 2™ Instrumented Otoscope contains position-detecting 
hardware that enables the OtoSim 2™ software to track the otoscope’s 
movement and orientation.  

The Instrumented Otoscope also tracks movements by controlling the display 
of the small cursor displayed on the ear.  
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(2) Realistic Ear Geometry  

The OtoSim 2™ Earform mould replicates the human ear and texture to 
provide realistic simulation.    

(3) OtoSim 2™ Content  

The content of OtoSim 2™ includes training modules to practice otoscopy; 
testing routines to rate diagnostic accuracy and efficiency; and otoscopy 
images include detailed descriptions of each clinical scenario. 

(4) OtoSim 2™ Software  

OtoSim 2™ software has an intuitive, easy-to-use graphic interface.  

Instructors can monitor what their students are viewing and highlight specific 
characteristics while students look through an actual otoscope and practice 
proper technique. This capability enhances student-instructor interactions.  

(5) Close the Learning Feedback Loop 

As students view and learn pathologies through the OtoSim 2™, instructors 
can interact with students by landmarking critical features of a pathology. 
This high degree of student-instructor interaction, combined with experiential 
learning in a realistic geometry, enables more efficient learning and 
knowledge retention.  
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4. OtoSim 2™ System Requirements 
The minimum requirements for the computer driving the OtoSim 2™ are 
listed below. Any recent laptop will likely meet the requirements. You may 
choose to assign a dedicated unit or use your personal computer. For 
software installations onto networked-computers, it is recommended to seek 
assistance from your IT department. 

• 350 megabytes (MB) of disk space for OtoSim 2™ software and 
DisplayLink driver software. 

• Two available USB 2.0 ports, or one USB 2.0 and a powered external 
USB hub (sold separately). 

• The DisplayLink driver will run on processors ranging from basic single 
Core CPUs, Dual, Quad Core and Core i3/i5/i7 CPUs. 1.2 GHz or above, 
with 512 MB RAM or more. 

! Please note that the processor speed, RAM capacity, and USB 
controller of your computer may affect multiplexing capabilities 
based on the following guidelines: 

o 1-2 OtoSim™ Units: 1.2 GHz CPU / 512 MB RAM 

o 2-5 OtoSim™ Units: 1.8 GHz CPU / 1 GB RAM 

o 6 OtoSim™ Units: 1.6 GHz Dual-Core CPU/ 2 GB RAM 

o 6+ OtoSim™ Units: please contact us for available options 

! For multiplexing, please use USB hubs defined as USB 2.0, with 
transfer rates of 480 MBPS (megabytes per second) and with an 
additional power source of 2.5 Amps or higher. Please refer to 
Section 6 for suggested configurations. 

• Any of the following operating systems: Mac OS X 10.7 (Lion), 10.8 
(Mountain Lion), 10.9 (Mavericks), 10.10 (Yosemite); Windows 8, 
Windows 7 (32-bit or 64-bit), Windows Vista with Service Pack 1 or 2 



 
 
 
 

OtoSim 2™ Installation and User Guide  
 
 

9 

(32-bit or 64-bit), Windows XP Home or Professional (including Tablet 
edition) with Service Pack 2 or 3. 

Note: Microsoft is no longer supporting Windows XP. Although the 
OtoSim 2™ software is compatible to Windows XP, we don’t recommend 
it. 

• Minimum WEI score of 3 in “Graphics; Desktop performance for 
Windows Aero”. 
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5. Base Unit Initial Setup 
1) Before using the Base Unit, you should remove the retaining ring from the 
Base Unit by turning it counter-clockwise. 

 

2) Place the OtoSim™ Earform into the cavity and secure it by tightening the 
retaining ring. (OtoSim™ Earforms are designed to fit into all existing 
OtoSim™ Base Units.) 
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6. Base Unit Hardware Configurations 
Below are the schematics of the OtoSim™ Base Unit hardware. Remember 
that there is no on/off switch; the electric power and digital images are 
supplied through the USB cable.  

It is recommended you become familiar with the single-unit configuration 
use before attempting to multiplex OtoSim™ Units (connect multiple units at 
the same time). 

 

6.1 Location to Plug USB Cable into Base Unit 

 

The USB port is located on the backside of the Base Unit. Insert the Type 
Mini B (smaller) end of the USB cable into the port on the Base Unit.  

*Be sure to align the USB cable plug and USB port on the Base Unit 
properly, to prevent damage to the port. 

*Be sure to loop the USB cable around the strain relief hook on the back of 
the Base Unit, to prevent pressure and damage to the port. 

 
 
 
 
 



 
 
 
 

OtoSim 2™Installation and User Guide 

 
 

12 

6.2 Connecting One Base Unit to the Computer  

 

The OtoSim™ Base Unit can be connected to a desktop computer or a laptop 
by inserting the Type A (larger) end of the USB cable into the port on the 
computer.  

Refer to Section 4 for system requirements to run OtoSim 2™. When 
connecting to networked-computers, it is recommended to seek assistance 
from your IT department. 

 

6.3 Multiplexing – Connecting Multiple Base Units to the Computer 

Fourteen Base Units are capable of running off of a single PC computer when 
all 14 Base Units are connected to OtoSim-supplied USB hubs. Due to 
factory settings, only 4 Base Units can run simultaneously from a Mac 
computer, when the units are connected to an OtoSim-supplied USB hub. 
OtoSim has tested a variety of USB hubs and highly recommend the use of 
the OtoSim-supplied hub for safe operation. Please ensure the following 
when multiplexing Base Units: 

- OtoSim recommends a maximum of 6 Base Units multiplexed to a single 
OtoSim-supplied USB hub for PC with Windows 8 (multiple USB hubs 
required for more than 6 units); 6 Base Units for PC with Windows 7, 
Vista or XP; and 4 Base Units for Mac.  
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- The USB hub is kept exposed in an area with good air circulation during 
use (i.e. not covered up). 

- When not in use, disconnect the USB hub and the Base Units (i.e. do not 
leave any OtoSim™ Unit running overnight). 

- We do not recommend more than 8 hours of continuous use. 

- Do not connect other high-current draw USB devices to the hub when 
OtoSim™ Base Units are connected to the hub, even if there are 
available USB ports on the hub. 
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7. Windows: Software Installation 
These instructions will guide you through the setup of your OtoSim 2™ 
software on a Windows PC. The following steps only need to be done once to 
load the software onto your computer. 

Note: For software installations onto networked-computers, please request 
assistance from your IT department. 

DO NOT PLUG IN THE BASE UNIT OR OtoSim 2™ SENSOR BOX 
UNTIL THE SOFTWARE INSTALLATION IS COMPLETE. 

* You do not need to remove OtoSim 1™ software (OtoSim™ 1.1, 1.2 or 
1.3) if it is already installed. Both OtoSim 1™ and OtoSim 2™ can be on 
the same computer and run independently. They cannot, however, run at 
the same time. 

 

7.1 OtoSim 2™ Software Installation 

1) Insert the provided USB key with the software into your computer. 
Double-click on the installation file. 

2) Please read the “Licenses terms and conditions”. If you agree, check “I 
agree to the License terms and conditions” and press “INSTALL” to begin 
the installation. 
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3) Before copying the OtoSim 2™ software to the computer, the installation 
package will install the pre-requisite software – DisplayLink. While the 
DisplayLink drivers install, the following screen will appear. (Do not change 
any settings or plug in any OtoSim™ Base Units while the installation 
progresses. The computer’s display may flash or turn off temporarily during 
this process.) 

 

4) Once the installation is complete, follow the prompts to restart the 
computer. 
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Note: The Base Unit should remain disconnected from the computer during 
the rebooting process. 

15) Congratulations, you have successfully installed the OtoSim 2™ software 
and DisplayLink drivers! The next step is the Display Setup. Go to Section 
7.2.1 if you are using Windows XP, Section 7.3.1 if you are using Windows 
Vista, Windows 7 or Windows 8 to set up the Base Unit. 

 

7.2 Windows XP Display Setup 

7.2.1 Windows XP: Verifying the Display Setup 

1) Connect the OtoSim™ Base Unit to an available USB port on the 
computer (see Section 6 for supported configurations)  

2) Go to “Display Properties” by either a) going through the Control Panel 
and selecting the “Display Properties” icon; or b) right-clicking on the 
desktop and selecting "Properties" from the pop-up menu. 

3) Select the “Settings” tab and verify that the secondary monitor (OtoSim™ 
Base Unit) appears as monitor #2. It should appear to the right of the main 



 
 
 
 

OtoSim 2™ Installation and User Guide  
 
 

17 

monitor (monitor #1), and the top edges of the two monitors should be 
aligned (see diagram below). 

 

 

4) Ensure that the “Extend my Windows desktop onto this monitor” option is 
checked under the Settings tab of the Display Properties Panel (see diagram 
above). 

5) To ensure connectivity, please click the “Identify” button and the number 
corresponding to the monitor will appear for several seconds. This can be 
seen on the LCD screen through the OtoSim™ Earform on the Base Unit. 

Note: The main monitor and the screen on the OtoSim™ Base Unit may 
flicker on and off for several seconds at a time. This is an indication 
that the computer is in the process of detecting the connected Base 
Unit. 
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7.2.2 Windows XP: Connecting Multiple Base Units 

Note: We recommend you operate the system with a single unit before using 
multiple Base Units at once. 

To connect multiple Base Units, please follow either A) or B) depending on 
your situation: 

A) Direct Connection to Computer 

Multiple Base Units can be individually connected to the available built-in 
USB ports of your computer. However, you will be limited to the number of 
available USB ports. Repeat the steps in Section 7.2.1 above, for each Base 
Unit to be connected, up to a maximum of 6 Base Units (depending on 
computer performance, as stated in Section 4). It is recommended to connect 
each Base Unit one at a time, and not all at once. 

OR 

B) Connection to Computer via USB Hub 

Multiple Base Units can be connected via a USB hub with the following 
instructions. We highly recommend using an OtoSim-supplied USB hub to 
multiplex Base Units. Refer to Section 6 for safe operation procedures when 
using a USB hub. 

i. Connect the USB hub first and allow the associated hub drivers 
to install. 

ii. Plug in the first Base Unit into the USB hub and allow time for 
the computer to detect this monitor. 

iii. Repeat the steps in Section 7.2.1 above, for each Base Unit to be 
connected, up to a maximum of 6 Base Units with Windows XP 
(depending on computer performance, as stated in Section 4). It 
is recommended to connect each Base Unit one at a time, and not 
all at once. 
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Congratulations, you have completed the Display Setup. Please close the 
“Display Properties” window and proceed to use the software! 

 

7.3 Windows Vista/7/8 Display Setup 

7.3.1 Windows Vista/7/8: Verifying the Display Setup 

1) Connect your OtoSim™ Base Unit to an available USB port on the 
computer (see Section 6 for supported configurations)  

2) Go to “Display Properties” by either a) going through the Control Panel, 
selecting the “Display Properties” icon and selecting the “Screen resolution” 
side menu; or b) right-clicking on the desktop and selecting “Screen 
Resolution” from the pop-up menu. 

3) Verify that the secondary monitor (OtoSim™ Base Unit) appears as 
monitor #2. It should appear to the right of the main monitor (monitor #1) 
and the top edges of the two monitors should be aligned (see diagram 
below). 

 

4) Ensure that “Extend desktop this display” is selected under the “Multiple 
Displays” category (see diagram above). 

5) Ensure that the “Extend” option is selected under the “Connect to a 
Projector” link found in the bottom area of the window (see diagram below). 
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6) To ensure connectivity, please click the “Detect” button and then click the 
“Identify” button. The number corresponding to the monitor will appear for 
several seconds. This can be seen on the LCD screen through the OtoSim™ 

Earform on the Base Unit. 

Note: The main monitor and the screen on the OtoSim™ Base Unit may 
flicker on and off for several seconds at a time. This is an indication 
that the computer is in the process of detecting the connected Base 
Unit. 

 

7.3.2 Windows Vista/7/8: Connecting Multiple Base Units 

Note: We recommend you operate the system with a single unit before using 
multiple Base Units at once. 

To connect multiple Base Units, please follow either A) or B) depending on 
your situation: 

A) Direct Connection to Computer 

Multiple Base Units can be individually connected to the available built-in 
USB ports of your computer. However, you will be limited to the number of 
available USB ports. Repeat the steps in Section 7.3.1 above, for each Base 
Unit to be connected, up to a maximum of 6 Base Units (depending on 
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computer performance, as stated in Section 4). It is recommended to connect 
each Base Unit one at a time, and not all at once. 

OR 

B) Connection to Computer via USB Hub 

Multiple Base Units can be connected via a USB hub with the following 
instructions. We highly recommend using an OtoSim-supplied USB hub to 
multiplex Base Units. Refer to Section 6 for safe operation procedures when 
using a USB hub. 

i. Connect the USB hub first and allow the associated hub drivers to 
install. 

ii. Plug in the first Base Unit into the USB hub and allow time for 
the computer to detect this monitor. 

iii. Repeat the steps in Section 7.3.1 above, for each Base Unit to be 
connected, up to a maximum of 6 Base Units with Windows 7, 
Vista or a maximum of 14 Base Units with Windows 8 
(depending on computer performance, as stated in Section 4). It is 
recommended to connect each Base Unit one at a time, and not all 
at once. 

Note: The image below is representative of 6 Base Units attached to the 
computer via a USB hub. The 7th monitor is the 6th Base Unit. The 
1st monitor represents the main monitor of the computer. 
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Congratulations, you have completed the Display Setup. Please close the 
“Screen Resolution” window and proceed to use the software! 
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8. Mac OS X: Software Installation 
These instructions will guide you through the setup of your OtoSim 2™ 
software on a Macintosh computer. The following steps only need to be done 
once to load the software onto your computer. 

Note: For software installations onto networked-computers, please request 
assistance from your IT department. 

DO NOT PLUG IN THE BASE UNIT OR OtoSim 2™ SENSOR BOX 
UNTIL THE SOFTWARE INSTALLATION IS COMPLETE. 

* You do not need to remove OtoSim 1™ software (OtoSim™ 1.1, 1.2 or 
1.3) if it is already installed. Both OtoSim 1™ and OtoSim 2™ can be on 
the same computer and run independently. They cannot, however, run at 
the same time. 

 

8.1 OtoSim 2™ Software Installation 

1) Insert the provided USB key with the software into your computer. Double 
click the installation file to install OtoSim 2™ on your computer. 

2) Double click the “DisplayLink Software Installer.pkg” file. (The 
DisplayLink drivers are required for the OtoSim™ Base Unit to function.) 



 
 
 
 

OtoSim 2™Installation and User Guide 

 
 

24 

 

6) Press “Continue” to proceed. 

 

7) You must accept the DisplayLink license agreement to proceed with the 
installation. If you accept the license agreement, press “Continue” and then 
“Agree” to proceed with the installation. 
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8) Press “Install” to continue with the installation. You will need to enter an 
administrator’s password to proceed. 
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9) When the DisplayLink software has been installed, you will be required to 
restart your computer. Press “Restart” to continue. (Do not change any 
settings or plug in any OtoSim™ Base Units while the installation 
progresses.) 

 

10) Congratulations, you have successfully installed the OtoSim 2™ software 
and DisplayLink drivers! Go to next section to set up the Base Unit. 
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8.2 Mac OS X Display Setup 

8.2.1 Mac OS X: Verifying the Display Setup 

1) Connect the OtoSim™ Base Unit to an available USB port on the 
computer (see Section 6 for supported configurations).  Allow a few seconds 
for the computer to detect the Base Unit.  

Note: The main monitor and the screen on the OtoSim™ Base Unit may 
flicker on and off for several seconds at a time. This is an indication 
that the computer is in the process of detecting the connected Base 
Unit.  

2) Click on the monitor icon at the top right of the menu bar, and select 
“Display Preferences”.  Or, you can access “Display Preferences” by clicking 
on the  icon on the top left of the computer, selecting “System Preferences”, 
and double-clicking on the “Displays” icon. 

 

              

3) In “Display Preferences”, click on the “Arrangement” tab and ensure that 
the secondary monitor (OtoSim™ Base Unit) is placed to the right of the 
main monitor and the top edges are aligned (see diagram below).  
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Note: Click on the “Gather Windows” button to move the Display 
Preferences windows onto the main monitor.  

 

8.2.2 Mac OS X: Connecting Multiple Base Units 

Note: We recommend you operate the system with a single unit before using 
multiple Base Units at once. 

To connect multiple Base Units, please follow either A) or B) depending on 
your situation: 

A) Direct Connection to Computer 

Multiple Base Units can be individually connected to the available built-in 
USB ports of your computer. However, you will be limited to the number of 
available USB ports. Repeat the steps in Section 8.2.1 above, for each Base 
Unit to be connected, up to a maximum of 4 Base Units (depending on 
computer performance, as stated in Section 4). It is recommended to connect 
each Base Unit one at a time, and not all at once. 

OR 
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B) Connection to Computer via USB Hub 

Multiple Base Units can be connected via a USB hub with the following 
instructions. We highly recommend using an OtoSim-supplied USB hub to 
multiplex Base Units. Refer to Section 6 for safe operation procedures when 
using a USB hub. 

i. Connect the USB hub first and allow the associated hub drivers 
to install. 

ii. Plug in the first Base Unit into the USB hub and allow time for 
the computer to detect this monitor. 

iii. Repeat the steps in Section 8.2.1 above, for each Base Unit to be 
connected, up to a maximum of 4 Base Units (depending on 
computer performance, as stated in Section 4). It is recommended 
to connect each Base Unit one at a time, and not all at once. 

 

Note: The image above is representative of 4 Base Units attached to the 
computer via a USB hub. 

Congratulations, you have completed the Display Setup. Please close the 
“Display Preferences” window and proceed to use the software! 
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9. OtoSim 2™ Sensor Box and Otoscope Hardware 
Configurations 
9.1 Setting Up the OtoSim 2™ Sensor Box 

The OtoSim 2™ Sensor Box is designed to be used only with the OtoSim 2™ 
provided Instrumented Otoscope.  

1) Connect the four-pronged circular cable to the bottom of the otoscope. 

  

 
2) Connect the other end of the cable to the hole at the top of the Sensor Box, 

as shown below. Now the Sensor Box and the provided Instrumented 
Otoscope are connected. 

 

3) Connect the Sensor Box to the computer, using the USB Cable. When 
powered up, the Sensor Box will display a green graph with the motion of 
the otoscope. (You may have to restart the OtoSim 2™ Sensor by 
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unplugging the USB cable and plugging it back in before you see the 
green motion graph.) 

 

Note: The two graphs at the bottom of the screen are intended solely as a 
diagnostic to verify that all the tracking circuitry is functioning correctly. 
If you do not see any motion when you move the otoscope, the Sensor 
Box may be malfunctioning. If the Base Unit displays “Not connected”, 
then you should ensure the cable between the Sensor Box and the 
Instrumented Otoscope is snugly connected and undamaged. 

4) When the OtoSim 2™ software is connected, the Sensor Box should now 
display the following screen.  
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9.2 Using the Otoscope 

The Otoscope should be held vertical when in use. This ensures the most 
accurate tracking, and is also consistent with medical best practices. The unit 
will not function correctly if held sideways. 

  

 

9.3 Storing the Otoscope 

The otoscope may be stored when not in use by attaching it to the side of the 
unit as pictured below: 
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10. OtoSim 2™ Software Use and Navigation 
The following section will describe the major features of the OtoSim 2™ 
software and the contents of each section. 

Please use only the Instrumented Otoscope provided with your OtoSim™ 
Base Unit when using the OtoSim 2™ software. Only the provided 
Instrumented Otoscope has the required tracking circuitry to connect with the 
OtoSim 2™ software. 

 

10.1 Navigating through the OtoSim 2™ Software 

10.1.1 Main Menu 

When OtoSim 2™ starts up, you will see the Main Menu screen below. 

 

On this page, you can click on each Module Header to expand the contents of 
that module and to explore the program. Sections 10.4 through 10.11 
summarize the content of the various modules.  
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Viewed sections will be highlighted red. However you may still revisit any of 
these sections.  

 

10.1.2 Searching 

If you are searching for a specific section, you can type into the “Find” box at 
the top. Suggestions will be highlighted in yellow as you type. To clear the 
search suggestions, simply press the “Clear” button.  

 

 

10.2 The Main Interface 

Each screen has an interface similar to the one below, which displays all the 
available functionality of the application. Each of these functions will be 
described in detail below.  
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1. The button “Switch to Left Ear” or “Switch to Right Ear” on the top-right 
of the image allows you to switch between viewing left or right ears. This 
change is also reflected in the OtoSim™ Base Unit when viewed through 
the Instrumented Otoscope.  

2. The page list on the right of the screen displays the available images. 
Images you have viewed are displayed in red, while un-viewed images are 
displayed in black. You can always return to viewed images again.  

3. The currently selected image is denoted by a gray band.  

4. Below the list of images, there is a description of the image. In this case, 
an example of “The Isthmus” is shown.  

5. Some images are annotated, and the table of annotations will be listed 
below the image description. By turning on the first column (by clicking 
on its red header), the landmark will be shown on the screen and on the 
Base Unit. By turning on the second column, landmarks will be hidden 
until clicked on with a mouse. By turning on the third column, the 
landmark and tracking of the Instrumented Otoscope will be visible on the 
main screen but will be hidden on the Base Unit until targeted with the 
Instrumented Otoscope. 
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6. The “Prev Page” and “Next Page” buttons will cycle through the various 
examples. The “Done” button will return you to the main menu.  

7. The slider on the bottom left controls the volume for annotations that are 
read by the computer.  

8. The control buttons are for (left to right): 1) Muting all sounds, 2) 
Drawing ellipses on the main window, 3) Drawing rectangles on the main 
window, 4) Erasing all annotations, and 5) Magnifying a portion of the 
main window.  

9. The second slider (bottom center) controls the brightness of the image. It 
should rarely need to be used.  

Note: All OtoSim images have been carefully calibrated to be as realistic as 
possible. So if an image appears very dark, that’s likely because a real 
ear with that disorder would be very dark as well. The modified image 
will be viewable in both the main screen and the OtoSim™ Base Unit. 

Note: The green targeting cross-hair (Viewfinder) may not be displayed at all 
times. The “View” menu at the top allows selection and control of the 
Viewfinder. The Full-screen Viewfinder (green cross-hair) is displayed 
by default and will only show if it is required, such as during the tool 
use tests. However, a Viewfinder of choice can be displayed to aid a 
trainee in orientating themselves by selecting the appropriate option 
under the “View” menu. 
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10. The “Turn OFF” button allows you to cover up the main screen so that a 
trainee must look through the OtoSim™ Base Unit to orient themselves or 
examine the image. This can be very helpful for self-directed learning.  
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10.3 Menu Bar Options 

At the top of the screen, there is a menu bar that contains many useful 
options. To access these options, click on the menus at the top of the screen.  

 

1. The File menu allows you to exit the program. Alternatively, you can use 
the “X” button on the top right corner (top left on Mac OS X).  
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2. The Voice menu allows you select between a male or female voice reading 
annotations. The default voice is male.  

 

3. The Text Size menu allows you to make text larger or smaller throughout 
the program. 
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4. The Tools menu allows calibrating your Instrumented Otoscope. Position 
the scope as shown in the picture and click on the “Calibrate Now” button. 
We suggest checking calibration regularly and to calibrate as frequently as 
required.  
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5. The View menu allows you to change how the View Finder displayed in 
the OtoSim™ Base Unit and on the instructor window is drawn.  

 

• The “Use Full-screen Viewfinder” option will use a cross that spans 
the entire screen. This is recommended for beginners who often find 
themselves disoriented in the OtoSim™ Base Unit.  
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• The “Use Small Viewfinder” option will only draw a small cross at the 
focal point of the screen. This may be useful for moderately advanced 
users.  
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• The “Use Arrow Viewfinder” option will draw a small arrow at the 
focal point of the screen. This may be useful if the other crosses are 
difficult to see.  

 

• The final option “Don’t Show Viewfinder” will not draw any cross or 
arrow. This is the default option as it presents the most realistic view 
of the ear. In situations where a cross is required, such as in the 
Instrument Use section, a cross will be displayed.  
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6. The Help menu allows you to view this manual again and learn about the 
people who helped make OtoSim a reality.  
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10.4 Introduction 

These sections are self-explanatory.  
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10.4.1 Welcome  

 

 

10.4.2 OtoSim Study  
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10.4.3 History of Otoscopy  

 

 

10.4.4 Holding an Ear  
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10.4.5 Holding an Otoscope  

It is critical that the OtoSim 2™ Instrumented Otoscope be held in the 
vertical position as shown for proper functioning and control of the 
Viewfinder. Further details are available in the Section 10.6 Instrument Use.  
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10.4.6 Ear Anatomy-Coronal View  

 

Selecting the “Item: Show ON” button at the top of the first column 
demarcates the anatomical structure on the main screen. This particular 
example highlights the pinna.  
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Selecting the “Screen: Auto OFF” button (Red turns Green) at the top of the 
second column now allows the student to practice identifying anatomical 
structures on the main screen using the point and click of the mouse. When 
correctly identified the annotation will appear around the structure on the 
main screen and the program will automatically advance to the next structure 
down the list until all are correctly identified. This particular example 
highlights the pinna.  

 

10.4.7 Ear Anatomy-Canal View  

Selecting the “Item: Show ON” at the top of the first column demarcates the 
anatomical structure on the main screen. This particular example highlights 
the light reflex.  

 

Selecting the “Screen: Auto OFF” button (Red turns Green) at the top of the 
second column now allows the student to practice identifying anatomical 
structures on the main screen using the point and click of the mouse. When 
correctly identified the annotation will appear on the main screen and the 
program will automatically proceed to the next structure down the list until 
all are correctly identified. This particular example highlights the umbo.  
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Selecting the “Next Page” button removes the tympanic membrane 
artistically revealing structures in the middle ear. Use the “Item: Show OFF” 
and “Screen: Auto OFF” buttons at the top of each column in a similar 
fashion as explained previously in Section 10.4.6. This particular example 
highlights the umbo.  
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Selecting the “Next Page” button removes the lateral temporal bone revealing 
the surrounding pertinent anatomy. Again toggle between columns until all 
anatomical structures are correctly identified. We hope you enjoyed the 
learning experience. This particular example highlights chorda tympani.  
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10.4.8 OtoSim Phone and Tablet Apps  

 

Please visit www.otosim.com for available Apps and other products.  

 

10.5 Visual Perception Tests  

Through years of experience, the inventors of OtoSim Inc. encountered many 
trainees with visual challenges. One important criterion in an effective 
diagnosis is the use of monocular vision through an otoscope.  

To ensure that practitioners have adequate visual acuity, OtoSim includes 
standard visual perception tests to be used with the Otoscope, which are 
designed to test monocular vision. It is recommended that before reviewing 
the content of the program, each user tests their vision using the Otoscope, 
and takes the necessary actions to correct one’s vision.  
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10.5.1 Visual Acuity  

The first page is to test visual acuity. If the trainee cannot read the first 4 or 5 
lines, they will not be able to diagnose effectively until their vision is 
corrected. Any vision correction should be prescribed by a licensed 
professional only.  
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10.5.2 Colour Blindness  

A red/green colour blindness image will be displayed. The trainee should see 
the number 74.  
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10.5.3 Shape Recognition  

There are 6 shapes. By clicking on one, you can display it on the OtoSim™ 
Base Unit and get the trainee to confirm that they can see it, and whether it is 
a representation of a 2D or 3D object.  

To return to the panel of shapes, press the “Back” button.  
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10.5.4 Depth Perception  

While the images are 2-dimensional, with shading, trainees should perceive 
the images to be 3-dimensional (concave or convex bumps). This image tests 
if they can extrapolate to 3D based on shading. The bumps on the left should 
be perceived as coming out, while the bumps on the right as going in.  

 

 

10.5.5 Interposition  

The blue circle should be perceived as being in front of the red one.  
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10.6 Instrument Use  

This module contains tests designed to familiarize trainees with using the 
Instrumented Otoscope with the OtoSim™ Base Unit. Each test will consist 
of a series of targets that trainees must find. They must then stay within each 
target for several seconds. The timer starts once the trainee has completed the 
first target.  

As the difficulty of each test increases, targets will decrease in size and their 
locations will vary. Each test will be timed. The lower the time, the better. To 
achieve proficiency, a trainee should practice regularly and aim to complete 
each test as quickly and efficiently as possible.  

Each test is only considered complete once every target has been viewed. It 
will then turn red in the main menu. However, each test can be taken multiple 
times to improve your score.  

This section requires using the OtoSim 2™ Instrumented Otoscope. 
Remember to calibrate the OtoSim 2™ Instrumented Otoscope as in Section 
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10.3 and to hold the scope near vertical during use as described in Section 
10.4.5.  

 

While viewing in the OtoSim™ Base Unit, follow the red broken line to the 
circular target. The circle border will turn red while within the target. Stay 
within the target until the countdown within the target reaches zero. The 
target will stay green in color and a new broken red line will guide you to the 
next target. Continue until all targets have been hit. The timer will stop and 
record your time to completion of the level. Practice to improve your time 
and accuracy and attempt all levels.  
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10.7 Feature Identification  

This module contains tests designed to help trainees identify major landmarks 
in the ear. The list on the side allows the user to choose between the various 
landmarks, which are reflected in the OtoSim™ Base Unit.  
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Each section is only considered complete once every landmark has been 
viewed. It will then turn red in the main menu. However, each section can 
still be revisited.  

 

Open the Normal Landmarks section.  

While viewing in the OtoSim™ Base Unit, target the structure highlighted in 
the chart with your Instrumented Otoscope. In this example the Primary Light 
Reflex is the selected target. It is visible on the main screen as a “hint”, but 
not when viewed on the Base Unit. Remember the main screen can also be 
hidden totally by a mouse click on the “Main Screen: Turn OFF” button. 
When accurately identified, the tympanic membrane will be removed to view 
the middle ear structures while continuing to annotate the position of the 
landmark selected. The remaining lateral temporal bone will then also be 
removed in a time-based manner. If you do not have the OtoSim 2™ 
Instrumented Otoscope, or wish to view activity on the main screen, simply 
use the computer mouse-click to target the anatomical structures listed in the 
chart. Remember to practice your skills on both right and left ears!  
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Accurately completed structures will appear red in the table. Work through 
the entire list. Have fun!  
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10.8 Pathology  

This module contains most of the OtoSim 2™ content, with multiple images 
for each different condition. This section is divided into various sections and 
sub-sections, which characterize each condition. The viewable subheadings 
are underlined and will turn blue when the mouse passes over them.  

Once a condition is selected, the trainee is free to examine it freely. However, 
annotations or other mark-up may be added by the instructor using the tools 
detailed in Section 10.2.   

Each section is only considered complete once every image in a section has 
been viewed. It will then turn red in the main menu. However, each section 
can still be revisited.  

As an example: In the Pathology Module, open the Middle Ear-Acquired 
Cholesteatoma section.  
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Some images are annotated, and the table of annotations will be below the 
image description. By turning on the first column (by clicking on its red 
header), the landmark will be shown on the screen and in the Base Unit.  
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By turning on the second column, landmarks will be hidden until clicked on 
with a mouse.  
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Work through the entire list.  

By turning on the third column, the landmark and tracking of the 
Instrumented Otoscope will be visible on the main screen but will be hidden 
in the Base Unit until targeted with the Instrumented Otoscope.  

 



 
 
 
 

OtoSim 2™ Installation and User Guide  
 
 

69 

Work through all pages of each section until completed denoted by red color. 
You may revisit any page at anytime.  

Note: Calibration of the OtoSim 2™ Instrumented Otoscope and proper 
holding and use of the scope are essential for complete satisfaction and 
maximal enjoyment. Remember to calibrate the OtoSim 2™  
Instrumented Otoscope as in Section 10.3 and to hold the scope near 
vertical during use as described in Section 10.4.5. Practice using the 
scope as described in Section 10.6 Instrument Use. Practice, practice, 
practice! 

  

10.9 Pneumatic Otoscopy 

This module specializes in demonstrating Pneumatic Otoscopy. This section 
is divided into two sections, one of which contains videos and the other 
allows for students and instructors to directly interact with each simulated 
pathology. For full functionality, additional hardware – PneumatoSim™ 
Upgrade Kit is required available through www.OtoSim.com.  

View videos of pneumatic otoscopy by selecting from the list. The videos can 
be projected onto the OtoSim™ Base Unit. 
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Simulation training for pneumatic otoscopy requires the PneumatoSim™ 
Upgrade Kit, which is not included with OtoSim 2™and can be purchased 
from us. 



 
 
 
 

OtoSim 2™ Installation and User Guide  
 
 

71 

 

This is a screen shot of PneumatoSim™. Dynamic movement of the tympanic 
membrane occurs with pressure generated from the Pneumatic Otoscope. 
Pressure generated is monitored and displayed to the student for maximum 
feedback and proper safe translation to clinical usage.  

Contact us at sales@otosim.com to purchase the PneumatoSim™ Upgrade 
Kit. 

 

10.10 Self Examination  

This module contains a variety of quizzes designed to prepare trainees for the 
examination. They are timed, but trainees are free to continue after the timer 
has expired. In addition, they will get as many attempts to answer each 
question as required. Questions do not have to be answered in order and each 
quiz is considered complete only once every question has been answered 
correctly.  

The goal of this module is to be a learning aid, not a rigorous examination, so 
trainees are free to attempt each quiz multiple times and use them to track 
their progress.  
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The following screen is shown before a quiz starts:  

 

1. This area shows the number of the current quiz.  

2. This shows the total number of questions in this quiz and the number of 
correct answers. 
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3. This shows the suggested amount of time to complete this quiz.  

4. The “Start Quiz” button will start the timer and reveal the first question.  

 

1. The box in the top left displays the amount of time remaining. It will 
slowly fill up as time passes. When full, an alert will sound, but the trainee 
can continue answering questions.  

2. If required, a trainee can pause the timer to take a break.  

3. This dropdown list allows trainees to jump to any other question in the 
quiz. 

4. The question is displayed in the box on the right.  

5. The possible answers are displayed in the list on the right. The trainee can 
choose their response by clicking in the area marked “Selection”, where 
they will get instant feedback telling them if they were correct or not.  

6. If a trainee was incorrect, a hint is displayed in this box to help them get 
the correct answer.  
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7. The “Next Question” button will take the trainee to the next unanswered 
or incorrect question.  

8. The “Done” button allows the trainee to return to the main menu. If every 
question is answered correctly, the quiz will be marked red in the main 
menu. However, the trainee is free to return to the quiz and reattempt it to 
refresh their knowledge.  

 

10.11 Anatomy Examination  

This module contains a variety of anatomical quizzes designed to prepare 
trainees for the examination. They are timed, but trainees are free to continue 
after the timer has expired. In addition, they will get as many attempts to 
answer each question as required. Questions do not have to be answered in 
order and each quiz is considered complete only once every question has 
been answered correctly.  

The goal of this module is to be an anatomical learning aid, not a rigorous 
examination, so trainees are free to attempt each quiz multiple times and use 
them to track their progress.  

There are 2 sections; the first requires use of the OtoSim 2™ Instrumented 
Otoscope and the Base Unit. The second is for use with the computer only 
and a mouse-pointing device.  
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The following screen is shown before a quiz starts:  

 

1. This area shows the number of the current quiz.  

2. This shows the total number of questions in this quiz and the number of 
correct answers.  
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3. This shows the suggested amount of time to complete this quiz.  

4. The “Start Quiz” button will start the timer and reveal the first question.  

 

1. The box in the top left displays the amount of time remaining. It will 
slowly fill up as time passes. When full, an alert will sound, but the trainee 
can continue answering questions.  

2. If required, a trainee can pause the timer to take a break. The trainee can 
then resume the timer with the same button.  

3. This dropdown list allows trainees to jump to any other question in the 
quiz.  

4. The question is displayed in the box on the right.  

5. An image of the ear is displayed here, if using the On-Screen version, the 
trainee will be required to click on the appropriate landmark on the image 
of the ear.  

6. The trainee is informed if they are correct in this box.  
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7. The “Next Question” button will take the trainee to the next unanswered 
or incorrect question.  

8. The “Submit” button allows the trainee to return to the main menu. If 
every question is answered correctly, the quiz will be marked red in the 
main menu. However, the trainee is free to return to the quiz and reattempt 
it to refresh their knowledge.  

The second section is for the On-Screen (Mouse) version. 

The computer mouse-pointing device is used to target the anatomical 
structure and the annotation appears when successfully identified by clicking 
on it on the main screen. 

 
This concludes the Software Use and Navigation for OtoSim 2™. 
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11. Troubleshooting 
• There is no on/off switch for the OtoSim™ Base Unit. It is fully 

powered by the USB cable when connected to the computer. 

• Make sure the USB hub you choose to use has an external power supply 
(AC adapter), is rated 480 MBPS, and is classified as USB 2.0. 

• Ensure your operating system is fully up-to-date. 

• Windows and its various updates may cause complications. Check for 
any software updates for your operating system and download them if 
there are any. 

• When in doubt, reboot the computer. Repeat Section 7 for PC; Section 8 
for Mac. 

o Please disconnect all Base Units and USB hubs before you restart 
your computer.  

o Once the computer reboots, give your computer time to load 
properly. 

• Without any Base Units connected, attach the USB hub first. Make sure 
the AC adapter for the USB hub is connected to a power source. Please 
refer to Section 6 for safe operation procedures. 

o Individually connect each Base Unit one-by-one. After plugging 
the first unit in, give time for the computer to process the 
connection. Your screen will flicker on/off, and your computer 
will emit a “USB-connected” sound. Wait several moments for 
the computer to process. 

o Insert the next Base Unit into the next port in the USB hub. 

• Ensure that the DisplayLink Drivers are fully up to date.  
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• If your laptop is attached to a docking station, you may encounter some 
display driver compatibility issues. As such, please disconnect the laptop 
from the docking station and proceed with normal installation and usage 
of the OtoSim™ Base Unit, as described in this manual. 

• If you are using dual monitors and the computer cannot detect the 
OtoSim™ Base Unit, make sure that the monitor is placed to the right-
side of the main monitor, with the top edges aligned (see diagrams in 
Sections 7.2 and 7.3 for PC; Section 8.2 for Mac). 

• To uninstall the OtoSim 2™ software, please utilize your computer’s 
standard uninstallation procedure. 

If you are still having trouble, or need someone to vent to, feel free to send us 
an email (info@otosim.com) and set-up an appointment for technical support. 
We will typically respond within 24 hours, Monday to Friday. Thank you for 
your continued support for our medical training and simulation products. 
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